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regard to the use of the software and documentation
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Description of menus and buttons
In the event that menu and button names on a Windows system are different from those on a Macintosh, this manual
uses the Windows menu and button names followed by the Macintosh menu and button names in parentheses.
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01V96 Editor enables you to remotely control the Yamaha 01V96 mixing console and to save the
parameter settings on your computer. To use 01V96 Editor, you must first perform the following
operations:
Start and configure Studio Manager.

2

Start and configure 01V96 Editor.

3

Synchronize 01V96 Editor with your 01V96 console (see page 4).
For more information on using Studio Manager, refer to the Studio Manager Owner’s Manual.

Configuring 01V96 Editor
You must configure the following settings for each open Editor.
Note:
• Specify MIDI ports in the Setup window of Studio Manager before making the following settings.
• To open each Editor, double-click the icon of the console or device you want to edit.
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Getting Started

❏ System Setup
Index

To open the System Setup window, choose [System Setup] from the [File] menu.
Be sure to specify the Input port and Output port.

Input port/Output port: From the ports you specified in Studio Manager, select the ports that
the editor will use to communicate with the 01V96 console.
Console Device ID: 01V96 Editor can control any one of up to eight 01V96 consoles, each with
its own exclusive ID. Select the ID of the console you want to control.
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❏ Console Setup
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Channel Select: These options determine whether or not channel selection is linked. When the
PC->Console option is on, selecting a channel in 01V96 Editor selects the same channel on the
console. When the Console->PC option is on, selecting a channel on the console selects the same
channel in 01V96 Editor.
Confirmation: These options determine whether or not a confirmation dialog box appears
when storing, recalling, or patching.
Layer Select: These options determine whether or not Layer selection is linked. When the
PC->Console option is on, selecting a Layer in 01V96 Editor selects the same Layer on the console.
When the Console->PC option is on, selecting a Layer on the console selects the same Layer in
01V96 Editor.
Window Control from Console: This option determines whether or not using the USER
DEFINED KEYS on the console enables you to remotely open and close the 01V96 Editor windows.
Level Meter: This option determines whether or not the level meters in 01V96 Editor are
enabled.

Index

To open the Console Setup window, choose [Console Setup] from the [File] menu.

Surround Mode: Select a Surround mode from STEREO, 3-1, 5.1, and 6.1.
Pair Mode: These options determine whether the fader pair is Horizontal or Vertical.
Channel Copy Parameter: Select desired parameters to copy from channel to channel.
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Select whether you want to transfer
your settings to 01V96 Editor, or vice
versa.
At this time, the All Libs option determines whether or not Scene and Library data is synchronized.
PC -> Console: Transfers the current parameter settings in 01V96 Editor to your console.
Console -> PC: Transfers the current parameter settings of your console to the 01V96 Editor.

3

Click [OK].
Do not operate the console while synchronization is in progress.
Note: If you use the “Total Recall” function in Studio Manager, all selected Editors in Studio Manager
are synchronized with the corresponding devices.

Getting Started
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When 01V96 Editor starts up, the parameter settings on the console and the parameter settings in
01V96 Editor may be different. Therefore, you must first match the parameter settings on the console with those in 01V96 Editor. This operation is called “synchronization.” Follow the steps below
to synchronize 01V96 Editor.
Select [Synchronize], then [Total
Recall...].
The following window opens.

Keyboard Shortcuts

Synchronizing 01V96 Editor

If you do not want to synchronize your console with 01V96 Editor, select [Offline Edit] from the
[Synchronization] menu. To apply your off-line edits to your console, select [Re-Synchronize]
from the [Synchronization] with the PC->Console option to synchronize the console with 01V96
Editor.
The Offline Edit function is also activated when you click the [ONLINE]/[OFFLINE] button in the
Master window.
Note: Some effect parameters in the console change their displayed values depending on the sampling
frequency. If you switch 01V96 Editor from OFFLINE to ONLINE, displayed parameter values may
change because 01V96 Editor loads the sampling frequency from the console and updates the display.

Working with Sessions
All of your console’s mix settings in 01V96 Editor, including Scene and library data, are called Sessions. The following table describes how to handle Sessions.
Creating a new Session

Choose [New Session] from the [File] menu.

Opening a previously saved Session

Choose [Open Session] from the [File] menu.

Saving the current Session

Choose [Save Session] from the [File] menu.

Saving the current Session with a new name

Choose [Save Session] As from the [File] menu.

Note: In order to save the settings of an optional Y56K card, in a Session, you must first resynchronize
01V96 Editor by selecting the Console->PC option.
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Offline Edit Function

Undo

Choose [Undo] from the [Edit] menu.

Redo

Choose [Redo] from the [Edit] menu.

Please note, however, that after you perform one of the following operations, you cannot successfully undo or redo any previous operation:
• Operations on the console
• Closing Studio Manager
• Changing Surround mode (Stereo/3-1/5.1/6.1)
• Changing Pair mode (Horizontal/vertical)
• Synchronizing the console with 01V96 Editor
• Creating a new Session
• Saving a Session
• Copying and pasting a channel
• Creating or cancelling a channel pair
• Storing or recalling a scene or library
• Turning on or off the GATE: [LINK] button in the Selected Channel window
• Turning on or off the COMPRESSOR: [LINK] button in the Selected Channel window
• Turning on or off the [LINK] button in the Surround Editor window
• Changing Aux Send mode (Fixed/variable) on the console
• Changing the sampling frequency (operated on the device)
• Changing the User Assignable Layer settings (operated on the device)
Note: You cannot Undo or Redo the following operations:
• Edits in the Setup window
• Synchronization
• Opening and closing the windows
• Resizing the windows
Note: In the Library window, you can Undo or Redo only the most recent operation. You cannot cancel
the preceding operations.

01V96 Editor—Owner’s Manual

5

Getting Started
UsingWindows
01V96 Editor
Windows

In 01V96 Editor, you can cancel the latest operation (Undo) and also cancel the cancellation of the
latest operation (Redo). If you perform an Undo operation twice in a row, you can cancel the two
most-recent operations. If you perform an Undo operation three times in a row, you can cancel the
three most-recent operations. In this way, you can cancel multiple recent operations. The following
table describes how to use the Undo/Redo function.

Keyboard Shortcuts

Undo/Redo Function

Index

If you save a Session in an Editor, only that Editor’s settings are saved in a file. The Editor’s settings
are saved in either the Studio Manager V2 format (file extension “.YSE”) or a format that is compatible with earlier versions of Studio Manager (file extension “.01X”). Note that earlier versions of
Studio Manager cannot open a Session saved in the “.YSE” format.
If you save a Session in the Studio Manager window, all selected Editor settings are saved in a file
with a file extension of “.YSM.”

You can copy and paste the channel parameters.
In the Console Setup window (page 3), you can also specify the parameters to be copied.
The following table describes how to use the Copy & Paste function.
Copying a channel

Right-click (<control>+click) a copy source channel, then choose [Copy].

Pasting a channel

Right-click (<control>+click) the copy destination channel, then choose
[Paste].

❏ Resetting to the default value (Ctrl ( ) + click)
Move the cursor to a control or a parameter value, then hold down the <Ctrl> key ( ) and click
the mouse button to reset the value to the default (e.g., to reset an Input Channel fader to –∞, or
reset a pan setting to Center).

❏ Ctrl( )+Shift+Click

Index

Move the cursor to a fader or AUX Send control, then hold down the <Ctrl> key ([ ]) and
<Shift> key and click the mouse button to reset the value to the nominal level.

Keyboard Shortcuts

❏ Copy & Paste Function
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Other Functions
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Using 01V96 Editor Windows
Master Window
1

The Master window enables you to switch between layers and control Stereo Out signals. To open this window, choose [Master] from the [Windows] menu.

Note: If 01V96 Editor is not connected or is not communicating with the 01V96,
clicking this button will not switch the unit from offline to online.
This indicator is displayed when 01V96 Editor is connected to the
01V96 correctly. If the connection is correct, the 01V96 Editor
parameters will work in unison with the 01V96 parameters.
This indicator is displayed when 01V96 Editor is not connected or is
not communicating with the 01V96, or when you have selected
Offline Edit. If the connection is incomplete, the 01V96 Editor
parameters will not work in unison with the 01V96 parameters.

2

B Meters

Index

3

These meters display the output level of the
Stereo Out when Surround mode is set to
“STEREO,” or the Bus Outs used for surround processing when Surround mode is
set to 3-1, 5.1 or 6.1. The meters in 3-1, 5.1
and 6.1 Surround modes are shown on the
right.

C LAYER buttons
4
5
6
7

These buttons are used to select the Layers.

D PAN CONTROL
3-1
5.1
6.1
These buttons are used to select either
“STEREO” (Stereo display mode) or
“SURR” (Surround display mode). The
Pan control on the Input Channels is a rotary control when “STEREO” is
selected, and a dot on a pan graph when “SURR” is selected. If Surround mode is
set to Stereo, the [SURR] button will be disabled.

E Scene number display
This display indicates the currently-recalled scene’s number.

F [SELECT] button
This button is used to select the Stereo Out.

8

G [ON] button
This button turns the Stereo Out on and off. It appears orange while the Stereo
Out is on.

H Master fader
This is the Stereo Out fader.

I Fader value indicator
9

This indicator indicates the fader position in decibels (dB).
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Repeatedly clicking this button toggles between online and offline status.

Windows

A [ONLINE]/[OFFLINE] button

7

❏ Input Channels
Selecting the 1-16 or 17-32 button in the Master window displays the corresponding
A Input Channel strips.

B A SOURCE parameter
This parameter is used to select an Input source. To select an Input source, click the
C
parameter and choose from the list that appears.
D
E B Routing buttons
F
These buttons are used to route the Input Channel to the Bus Outs.
G
H
I C [STEREO] button
J
This button is used to route the Input Channel’s signal to the Stereo Out.
K
D [DIRECT] button
L
This button turns on and off the Input Channel’s routing to its Direct Out.
M
E Direct Out parameter
N
This parameter is used to select the Direct Out destination. To select a destination,
click the parameter and choose from the list that appears.
O

F [PHASE] button
This button is used to reverse the signal phase of the channel.

G [INSERT] button
This button is used to turn on and off the Input Channel’s Insert.

H [GATE] button
This button is used to turn on and off the Input Channel’s Gate.

I Gate open/close indicators
These indicators display whether the Gate is open (green) or closed (red).

J Gate threshold
This displays the Gate Threshold, which can be set by dragging.

K [COMP] button
This button is used to turn on and off the Input Channel’s Compressor.

L Compressor curve
This display shows the Compressor’s curve.

M [EQ] button
This button is used to turn on and off the Input Channel’s EQ.

N EQ curve
This display shows the Equalizer’s curve, which can be set by dragging.

O [DELAY] button
This button is used to turn on and off the Input Channel’s Delay function.
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Note:
• You can selectively turn on or off some of channel strips by using the [View] menu.
• You can open multiple Layer windows by choosing [Windows] menu -> [Layer] -> [Additional View].
The titles of these windows will indicate [Locked]. Windows that are indicated as [Locked] will not
reflect layer changes made on the console or in the Master window. If you want the Layer windows to
reflect the changes, right-click each window (Macintosh: <control> + click), then select the desired layer
using the LAYER buttons.

Keyboard Shortcuts

The Layer window displays 16 channel strips. You can select a layer using the LAYER buttons in the
Master window. To open the Layer window, choose [Layer] from the [Windows] menu.

Index

Layer Windows

This parameter is used to set the delay time of the Delay function. Delay times can be
set by dragging.

Q Channel number
This is the channel number. Double-click the channel number to open the Selected
Channel window.

Getting Started

P Delay parameter

R AUX section

S
T
V
W
X
Y

Appearance

On or off but no level set

Dark blue bar

Off, pre-fader

Green bar outline displays level

On, pre-fader

Green bar displays level

Off, post-fader

Orange bar outline displays level

On, post-fader

Orange bar displays level

S Pan/Aux Send display
This display shows the stereo or surround pan position or, while setting an Aux Send,
the Aux Send level in dB.

T PAN control
This control is used to set the Input Channel’s stereo or surround pan position.
When the PAN CONTROL in the Master Window is set to “STEREO,” the Pan control appears as a rotary control, and when set to “SURR,” the control appears as dot
on a pan graph. The surround pan position can be set by dragging the dot.

U LFE control
Z

When 5.1 or 6.1 Surround mode is selected, this control is used to set the
surround LFE Channel level. It appears when the PAN CONTROL in the
Master Window is set to “SURR.” To set the Channel level, drag the end of
its bar or click a point along the length of the bar.

V [SELECT] button

U

This button is used to select the Input Channel.

W [SOLO] button
This button solos the Input Channel. It appears orange while the channel is soloed.

a

Keyboard Shortcuts

R

Aux Send status

X [ON] button
This button turns the Input Channel on and off. It appears orange while the channel
is on.

Y Short channel name
This is the channel’s short name. To edit the name, click it and type.

Z Channel fader and channel meter
This is the Input Channel fader. The channel meter to the right of the fader displays
the Input Channel signal level.

a Fader value indicator
The fader value indicator indicates the fader position in decibels (dB).
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These controls are used to set the levels of the Aux Sends. To set an Aux
Send level, drag its bar or click a point along the length of the bar. To turn
an Aux Send on or off, click its number.
The following table shows how the Aux Send controls appear depending
on the Aux Send On/Off and Pre/Post settings. Aux Sends can be set to
pre-fader or post-fader on the Selected Channel window (see “AUX
SEND section” on page 15).

C
D

This parameter is used to select an Input source. To select an Input source, click the
parameter and choose from the list that appears.

B Routing buttons
These buttons are used to route the Input Channel to the Bus Outs.

C STEREO button
This button is used to route the Input Channel’s signal to the Stereo Out.

UsingWindows
01V96 Editor
Windows

B

A SOURCE parameter

D PHASE button
This button is used to reverse the signal phase of the channel.

E EQ button

G
8

I
J
L
M
N
O

P

This button is used to turn on and off the Input Channel’s EQ.

F EQ curve
This display shows the Equalizer’s curve, which can be set by dragging.

G Channel number
This is the channel number. Double-clicking this will open the Selected Channel
window.

H AUX section
These controls are used to set the levels of the Aux Sends. To set an Aux
Send level, drag its bar or click a point along the length of the bar. To turn
an Aux Send on or off, click its number.
The following table shows how the Aux Send controls appear depending
on the Aux Send On/Off and Pre/Post settings. Aux Sends can be set to
pre-fader or post-fader on the Selected Channel window (see “AUX
SEND section” on page 15).
Aux Send status

Index

E
F

Appearance

On or off but no level set

Dark blue bar

Off, pre-fader

Green bar outline displays level

On, pre-fader

Green bar displays level

Off, post-fader

Orange bar outline displays level

On, post-fader

Orange bar displays level

I Pan/Aux Send display
This display shows the stereo or surround pan position or, while setting an Aux Send,
the Aux Send level in dB.

J PAN control
Q

This control is used to set the Input Channel’s stereo or surround pan position.
When the PAN CONTROL in the Master Section is set to “STEREO,” the Pan control
appears as a rotary control, and when set to “SURR,” the control appears as dot on a
pan graph. The surround pan position can be set by dragging the dot.

K LFE control
When 5.1 or 6.1 Surround mode is selected, this control is used to set the
surround LFE Channel level. It appears when the PAN CONTROL in the
Master Section is set to “SURR.” To set the LFE level, drag the end of its
bar or click a point along the length of the bar.

K

L SELECT button
This button switches between L and R of a stereo input channel.
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❏ Stero Input Channel
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This button solos the Input Channel. It appears orange while the channel is soloed.

N ON button
This button turns the Input Channel on and off. It appears orange while the channel
is on.

O Short channel name

Getting Started

M SOLO button

This is the channel’s short name. To edit the name, click it and type.
This is the Input Channel’s fader. The meter at the right of the fader indicates the signal level.

Q Fader value

Index

Keyboard Shortcuts

This indicates the dB value of the fader.

UsingWindows
01V96 Editor
Windows

P Channel fader/Channel meter
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When you select the Master LAYER button in the Master window, the Bus Out and Aux
Send channels are displayed. The Aux Send channel appears the same as the Bus Out
channels except that the Bus Out channels feature a [STEREO] button.

A

A [STEREO] button (Bus Out only)
This button is used to route the Bus Out to the Stereo Out.

Getting Started

❏ Output Channels

B [INSERT] button
B

This button is used to turn on and off the Bus Out’s Insert.

C [COMP] button
Windows

D
E
F
G
H
I

This button is used to turn on and off the Bus Out’s Compressor.

D Compressor curve
This display shows the Compressor’s curve.

E [EQ] button
This button is used to turn on and off the Bus Out’s EQ.

F EQ curve
This display shows the Equalizer’s curve, which can be set by dragging.

G [DELAY] button
This button is used to turn on and off the Bus Out’s Delay function.

H Delay parameter
This parameter is used to set the delay time of the Delay function. Delay times can be
set by dragging.

Keyboard Shortcuts

C

I Channel number

J [SELECT] button

Index

J
K
L
M

This is the channel number. Double-click the channel number to open the Selected
Channel window.
This button is used to select the Bus Out.

K [SOLO] button
This button solos the Bus Out. It appears orange while the Bus Out is soloed.

L [ON] button
This button turns the Bus Out on and off. It appears orange while the Bus Out is on.

N

M Short channel name
This is the channel’s short name. To edit the name, click it and type.

N Channel fader and channel meter
This is the Bus Out fader. The meter to the right of the fader displays the Bus Out signal level.

O Fader value indicator
O

The fader value indicator indicates the fader position in decibels (dB).
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When you select the REMOTE LAYER button in the Master window, Remote Channels
are displayed.

A Channel number
This is the channel number. Double-click the channel number to open the Selected
Channel window.

Getting Started

❏ Remote Channels

B [SELECT] button
This button is used to select the Remote Channel.
This button turns the Remote Channel on and off. It appears orange while the channel is on.
Note: When the remote target setting on the 01V96 is set to User Defined, you can
use the [ON] buttons and channel faders to control the functions specified on the
Remote page.

Windows

C [ON] button

D Remote target name
This name indicates the remote target assigned on the 01V96.

Keyboard Shortcuts

A

E Channel fader
This is the Bus Out’s fader.
Note: When the remote target setting on the 01V96 is set to User Defined, you can
use the [ON] buttons and channel faders to control the functions specified on the
Remote page.

F Fader value indicator
B
C
D

If the remote target is set to User Assignable Layer:
In this case, the assigned channels are displayed. For more information, refer to “Input
Channels” on page 8 and “Output Channels” on page 12. If the Group Master Fader is
assigned, only the [SOLO], and [ON] buttons and channel faders are displayed.

E

F
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This indicator indicates the fader position in the range of 0 through 127.

Keyboard Shortcuts

Note: You can open multiple Selected Channel windows by choosing [Windows] menu ->
[Selected Channel] -> [Additional View]. The titles of these windows will indicate
[Locked]. You cannot open Library windows from windows that are indicated as [Locked].
In addition, these windows will not reflect the following operations:
• Channel selections made in the Layer window (via the SELECT button)
• Edits in the Surround Editor window

❏ Input Channels
C

D

E

F

Index

A B

Getting Started

The Selected Channel window allows detailed editing of the currently selected channel. To open the
Selected Channel window, choose [Selected Channel] from the [Windows] menu.
There are five variations of the layout of the Selected Channel window, as follows:
• Input Channels (see below)
• Stereo Input Channels (see page 16)
• Bus Outs (see page 17)
• Aux Sends (see page 18)
• Stereo Outs (see page 19)

UsingWindows
01V96 Editor
Windows

Selected Channel Window

G H

I

A CHANNEL SELECT, INPUT PATCH & LIBRARY section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Channel ID. To edit the name, click it and type. The INPUT PATCH parameter is used to select an input
source. To select an input, click the parameter and choose from the list that appears. The [LIBRARY]
button opens the Channel Library window.

B GATE section
This section contains the Gate controls and display graph for the currently selected Input Channel.
The rotary controls are used to set the threshold, range, attack, decay, and hold. The GR meter indicates the amount of gain reduction being applied by the Gate. The OUT meter indicates its output
level. The [ON] button turns the Gate on and off. The [LINK] button links the Gate of the currently
selected Input Channel with the Gate of its partner channel. The KEY IN parameter is used to select a
Gate trigger source. The [LIBRARY] button opens the Gate Library window.

01V96 Editor—Owner’s Manual
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This section contains the delay and phase controls for the currently selected Input Channel. The rotary
controls are used to set the delay time, feedback gain, and mix balance (wet/dry balance). The [ON]
button turns the Delay on and off. The [PHASE] button reverses the channel’s signal phase.

E ROUTING, PAN & level section
This section contains the routing, pan, and level controls and the [SOLO], and [ON] buttons for the
currently selected Input Channel. ROUTING buttons 1–8 are used to route the channel to the Bus
Outs. The [STEREO] button routes the channel to the Stereo Out. The [DIRECT] button routes the
channel to its Direct Out, and the Direct Out parameter below it selects a Direct Out destination. The
[F.PAN] button turns on and off the Bus Out Follow Pan function. The PAN control is used to pan the
channel. The [SOLO] button is used to solo the channel, the [ON] button, to turn on and off the channel, and the channel fader, to set the channel level. The meter to the right of the fader indicates the
signal level, and the value indicator under the fader indicates the fader position in decibels (dB).

F AUX SEND section
This section contains the Aux Send controls for the currently selected Input Channel. Use the rotary
controls to set the Aux Send levels, and click them to turn Aux Sends on and off. Use the button below
each Aux Send control to select pre-fader or post-fader. In Fixed mode, this button is used to turn Aux
Sends on and off (the level is fixed at nominal).
When Aux Sends are paired, a heart icon is displayed between them, and the odd-numbered Aux Send
control sets the level, while the even-numbered control works as a pan control.

UsingWindows
01V96 Editor
Windows

D DELAY & PHASE section

Keyboard Shortcuts

This section contains the EQ controls and display graph for the currently selected Input Channel. The
rotary controls are used to set the gain, center frequency, and Q of each band, and the pre-EQ attenuation
level. EQ can also be set by dragging the EQ curve on the EQUALIZER graph. The [ON] button turns the
EQ on and off. The TYPE buttons select the EQ type. The [LIBRARY] button opens the Equalizer Library
window.

Getting Started

C EQUALIZER section

This section contains the Insert parameters for the currently selected Input Channel. The [ON] button
turns the Insert on and off. The OUT and IN parameters are used to specify the insert out destination
and insert in source respectively. The POSITION parameter is used to specify the position of the Insert
in the signal path.

H COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Input
Channel. The rotary controls are used to set the threshold, ratio, attack, release, gain, and knee. The
GR meter indicates the amount of gain reduction being applied by the Compressor. The OUT meter
indicates its output level. The [ON] button turns the Compressor on and off. The [LINK] button links
the Compressor of the currently selected Input Channel with the Compressor of its partner channel.
The POSITION parameter is used to specify the position of the Compressor in the signal path. The
ORDER parameter is used to specify the order of the Compressor and Insert when both are inserted
at the same position. The [LIBRARY] button opens the Compressor Library window.

I PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected
Input Channel. Click the heart icon to pair and unpair the channel with its partner channel. Use the FADER GROUP buttons to add the channel to Fader groups, and use the
MUTE GROUP buttons to add it to Mute groups.

01V96 Editor—Owner’s Manual
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Index

G INSERT section

2 3

D

5

A CHANNEL SELECT, INPUT PATCH & LIBRARY section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Channel ID. To edit the name, click it and type. The INPUT PATCH parameter is used to select an input
source. To select an input, click the parameter and choose from the list that appears. The LIBRARY
button opens the Channel Library window.

B PHASE section
This section contains the phase control for the currently selected Stereo Input Channel. The PHASE
button reverses the channel’s signal phase.

C EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Stereo Input Channel. The rotary controls are used to set the gain, center frequency, and Q of each band, and the pre-EQ
attenuation level. EQ can also be set by dragging the EQ curve on the EQUALIZER graph. The ON
button turns the EQ on and off. The TYPE buttons select the EQ type. The LIBRARY button opens
the Equalizer Library window.

D Routing, pan & level section
This section contains the routing, pan, and level controls and the, SOLO, and ON buttons for the currently selected Stereo Input Channel. ROUTING buttons 1–8 are used to route the channel to the Bus
Outs. The STEREO button routes the channel to the Stereo Out. The DIRECT button routes the channel to its Direct Out, and the Direct Out parameter below it selects a Direct Out destination. The
F.PAN button turns on and off the Bus Out Follow Pan function. The PAN control is used to pan the
channel. The SOLO button is used to solo the channel, the ON button, to turn on and off the channel,
and the channel fader, to set the channel level.

E AUX SEND section
This section contains the Aux Send controls for the currently selected Stereo Input Channel. Use the
rotary controls to set the Aux Send levels, and click them to turn Aux Sends on and off. Use the button
below each Aux Send control to select pre-fader or post-fader. In Fixed mode, this button is used to
turn Aux Sends on and off (the level is fixed at nominal).
When Aux Sends are paired, a heart icon is displayed between them, and the odd-numbered Aux Send
control sets the level, while the even-numbered control works as a pan control.
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Index

6

Keyboard Shortcuts

UsingWindows
01V96 Editor
Windows

A

Getting Started

❏ Stereo Input Channels

This section contains the Fader and Mute group functions for the currently selected Stereo Input
Channel. Use the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE
GROUP buttons to add it to Mute groups.

❏ Bus Outs
B

C

D

Keyboard Shortcuts

UsingWindows
01V96 Editor
Windows

A

Getting Started

F FADER GROUP & MUTE GROUP section

G

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Channel ID. The [LIBRARY] button opens the Channel Library window.

B EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Bus Out. It’s layout
is identical to the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for
more information.

C DELAY section
This section contains the delay controls for the currently selected Bus Out. The rotary control is used
to set the delay time, and the [ON] button turns the Delay function on and off.

D TO STEREO & level section
This section contains the TO STEREO, pan and level controls and the [SOLO], and [ON] buttons for
the currently selected Bus Out. The TO STEREO button routes the Bus Out to the Stereo Out, and the
rotary controls are used to set the Bus to Stereo send level and pan. The [SOLO] button is used to solo
the Bus Out, the [ON] button, to turn the Bus Out on and off, and the channel fader, to set the Bus
Out level. The meter to the right of the fader indicates the signal level, and the value indicator under
the fader indicates the fader position in dB.

E INSERT section
This section contains the Insert parameters for the currently selected Bus Out. The [ON] button turns
the Insert on and off. The OUT and IN parameters are used to select the insert out destination and
insert in source respectively. The POSITION parameter is used to specify the position of the Insert in
the signal path.
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Index

E F

This section contains the Compressor controls and display graph for the currently selected Bus Out.
Its layout is identical to the COMPRESSOR section for Input Channels. See “COMPRESSOR section”
on page 15 for more information.

G PAIR, FADER GROUP & MUTE GROUP section

UsingWindows
01V96 Editor
Windows

This section contains the Pair, Fader and Mute group functions for the currently selected
Bus Out. Click the heart icon to pair and unpair the channel with its partner channel. Use
the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE
GROUP buttons to add it to Mute groups.

❏ Aux Sends
B

C

D

Index

Keyboard Shortcuts

A

Getting Started

F COMPRESSOR section

E F

G

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and choosing from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Channel ID. The [LIBRARY] button opens the Channel Library window.

B EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Aux Send. It’s layout
is identical to the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for
more information.

C DELAY section
This section contains the delay controls for the currently selected Aux Send. The rotary control is used
to set the delay time, and the [ON] button turns the Delay function on and off.

D Aux Send level section
This section contains the [SOLO], and [ON] buttons and the channel fader for the currently selected
Aux Send. The meter to the right of the fader indicates the signal level, and the value indicator under
the fader indicates the fader position in decibels (dB).

E INSERT section
This section contains the Insert parameters for the currently selected Aux Send. The [ON] button
turns the Insert on and off. The OUT and IN parameters are used to specify the insert out destination
and insert in source respectively. The POSITION parameter is used to specify the position of the Insert
in the signal path.
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This section contains the Compressor controls and display graph for the currently selected Aux Send.
Its layout is identical to the COMPRESSOR section for Input Channels. See “COMPRESSOR section”
on page 15 for more information.

G PAIR, FADER GROUP & MUTE GROUP section

UsingWindows
01V96 Editor
Windows

This section contains the Pair, Fader and Mute group functions for the currently selected
Aux Send. Click the heart icon to pair and unpair the channel with its partner channel. Use
the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE
GROUP buttons to add it to Mute groups.

❏ Stereo Out
B

C

D

Index

Keyboard Shortcuts

A

Getting Started

F COMPRESSOR section

E F

G

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and choosing from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Channel ID. The [LIBRARY] button opens the Channel Library window.

B EQUALIZER section
This section contains the EQ controls and display graph for the Stereo Out. It’s layout is identical to
the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for more information.

C DELAY section
This section contains the delay controls for the Stereo Out. The rotary control is used to set the delay
time, and the [ON] button turns the Delay function on and off.

D Balance & level section
This section contains the balance control, [ON], and channel fader for the Stereo Out. The meter to
the right of the fader indicates the signal level, and the value indicator under the fader indicates the
fader position in decibels (dB).

E INSERT section
This section contains the Insert parameters for the Stereo Out. The [ON] button turns the Insert on
and off. The OUT and IN parameters are used to specify the insert out destination and insert in source
respectively. The POSITION parameter is used to specify the position of the Insert in the signal path.
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This section contains the Compressor controls and display graph for the currently selected Stereo Out.
Its layout is identical to the COMPRESSOR section for Input Channels except there is no [LINK] button. See “COMPRESSOR section” on page 15 for more information.

G FADER GROUP & MUTE GROUP section

Index

Keyboard Shortcuts

UsingWindows
01V96 Editor
Windows

This section contains the Fader and Mute group functions for the Stereo Out. Use the FADER GROUP
buttons to add the Stereo Out to Fader groups, and use the MUTE GROUP buttons to add it to Mute
groups.

Getting Started

F COMPRESSOR section
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The Library window enables you to control and manage Scenes and libraries. In addition, Scenes and
libraries can be saved to disk on your computer as Library files.
To open the Library window, choose [Library] from the [Windows] menu. The Library window consists of 8 display pages. You can access each of these pages by clicking the tabs along the top of the window, or by following the action described below:
Action

Gate Library

UsingWindows
01V96 Editor
Windows

Channel Library
[LIBRARY] buttons on the Selected Channel window

Compressor Library
Equalizer Library
Input Patch Library
Output Patch Library
Effect Library

[LIBRARY] button on the Patch Editor window
[LIBRARY] buttons on the Effect Editor window

The layout of the Library window pages is the same regardless of which page is selected (the Scene
Memory library is shown below). The Library window consists of two panes. The pane on the left,
called the [FILE] section, displays the status of the currently open library file. The pane on the right,
called the [INTERNAL DATA] section, displays the status of the corresponding library in the console.
You can copy and sort the items in the list (memories) by dragging them between the panes. Within
the same pane, you can copy a memory by dropping it on top of another memory, and you can sort
memories by dropping a memory between two memories. Memory contents can be swapped by holding down the <Shift> key while dragging. In all cases, the contents of the destination memory are
overwritten. To edit a memory title, click the title, then type.

Keyboard Shortcuts

Library page

Getting Started

Library Window

Index

ABC D E

J
K
N
O
P

F

L G H I

M

A File name
This is the file name of the currently open Library file.
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This button is used to open Library files.
Note: 01V96 Editor may be unable to open some files stored in SmartMedia. In this case, copy those files
onto a hard disk, then try to open them in 01V96 Editor.

C [CLOSE] button
This button is used to close the currently open Library file.

Getting Started

B [OPEN] button

D [SAVE] button

This button is used to save the currently open Library file with a different name.

F TITLE
This column displays the memory titles.

G PROTECT (only for Scene memories)
This column displays padlock icons for protected memories. It also displays an “ ” (read-only) icon
for preset data.

H INPUT PATCH LINK (only for Scene memories)
This column displays the input patch memory numbers linked to the Scene library. When you store
or recall a Scene memory, the linked Input Patch Library memory is stored or recalled at the same
time.

I OUTPUT PATCH LINK (only for Scene memories)
This column displays the Output Patch memory numbers linked to the Scene library. When you store
or recall a Scene memory, the linked Output Patch Library memory is stored or recalled at the same
time.

Keyboard Shortcuts

E [SAVE AS] button

UsingWindows
01V96 Editor
Windows

This button is used to save the currently open Library file.

J [STORE] button
Note: In the Effect Library page, the number of the internal effect processor to which the store/recall operation applies is shown above the [STORE] button.

K [RECALL] button
This button is used to recall the selected memory.

L [FILE] section
This section displays the contents of the currently open library file.

M [INTERNAL DATA] section
This section displays the console’s status of the currently selected library.
Note: If the OFFLINE indicator is selected by the [ONLINE]/[OFFLINE] button in the Master window,
01V96 Editor is not synchronizing with the console. Therefore, this section does not display the console’s
correct status.

N [CLEAR] button
This button clears the selected memory from the list.

O [UNDO] button
This button undoes the last recall, store, copy, clear, sort or titling operation.
Note: In the Library window, you can undo only the most recent operation. You cannot undo any operations performed prior to the most recent operation.

P [PROTECT] button (only for Scene memories)
This button is used to protect or unprotect the selected memory.
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Index

This button is used to store the contents of the library to the specified location.

The Patch Editor window is used to patch Inputs, Outputs, Inserts, Effects, and Direct Outs. To open
this window, choose [Patch Editor] from the [Windows] menu. This window consists of five pages,
which you can select by clicking the tabs along the top of the window.

❏ INPUT PATCH Page
B

C

D

E
UsingWindows
01V96 Editor
Windows

A

Getting Started

Patch Editor Window

Keyboard Shortcuts

F

Index

G

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [AUTO SETUP] button
Clicking this button sets the patches on this page to their initial values.

D [ALL CLEAR] button
This button clears all patches on this page.

E [LIBRARY] button
This button opens the Input Patch Library window.

F Port names
These are the Port names.

G Patchbay
The patchbay is used to patch input ports to Input Channels. Active patches are indicated by a blue
dot. To make a patch, click a square. To unpatch, click a blue dot.
Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.
Note: Input sources (AD1–AUX8) that are assigned to a cascade connection (CAS BUS1–CASSOLOR)
cannot be assigned to non-cascade-connected channels (CH1–32).
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A

B

C

D

Getting Started

❏ OUTPUT PATCH Page
E

UsingWindows
01V96 Editor
Windows

F

Keyboard Shortcuts

G

A Channel IDs
These are the Channel IDs.

B Long channel names
Index

These are the Channel long names. To edit a name, click it and type.

C [AUTO SETUP] button
Clicking this button sets the patches on this page to their initial values.

D [ALL CLEAR] button
This button clears all patches on this page.

E [LIBRARY] button
This button opens the Output Patch Library window.

F Port names
These are the Port names.

G Patchbay
The patchbay enables you to patch output ports to Output Channels. Active patches are indicated by
a red dot. To make a patch, click a square. To unpatch, click a red dot.
Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.
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A

B

Getting Started

❏ INSERT PATCH Page
C

Keyboard Shortcuts

E

UsingWindows
01V96 Editor
Windows

D

F

A Channel IDs
These are the Channel IDs.
Index

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [LIBRARY] buttons
These buttons open the Input and Output Patch Library windows.

D Port names
These are the Port names.

E Insert Out Patchbay
This patchbay is used to patch output ports to the Insert Outs of Input Channels, Bus Outs, Aux Sends,
and the Stereo Out. Active patches are indicated by a red dot. To make a patch, click a square. To
unpatch, click a red dot.

F Insert In Patchbay
This patchbay is used to patch input ports to the Insert Ins of Input Channels, Bus Outs, Aux Sends,
and the Stereo Out. Active patches are indicated by a blue dot. To make a patch, click a square. To
unpatch, click a blue dot.
Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.

01V96 Editor—Owner’s Manual

25

B

Keyboard Shortcuts

UsingWindows
01V96 Editor
Windows

A

Getting Started

❏ EFFECT PATCH Page

A Effects processor 1–4 section
This section indicates the effects name assigned to internal Effects processor 1–4. The parameters in
this section are used to select inputs and outputs for Effects processor 1–4.

Index

B [LIBRARY] button
This button opens the Input Patch Library window.
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A

B

Getting Started

❏ DIRECT OUT PATCH Page
C

UsingWindows
01V96 Editor
Windows

D

Keyboard Shortcuts

E

A Channel IDs
These are the Channel IDs.

B Long channel names
Index

These are the Channel long names. To edit a name, click it and type.

C [LIBRARY] button
This button opens the Output Patch Library window.

D Port names
These are the Port names.

E Patchbay
The patchbay is used to patch output ports to the Direct Outs. Active patches are indicated by a red
dot. To make a patch, click a square. To unpatch, click a red dot.
Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.
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The Surround Editor window enables you to edit the surround pan position of the currently selected
Input Channel. To open the Surround Editor window, choose [Surround Editor] from the [Windows]menu.

Getting Started

Surround Editor Window

A

B
E

F
G
C

H

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Channel ID. To edit the name, click it and type.

Keyboard Shortcuts

UsingWindows
01V96 Editor
Windows

D

The green dot on this graph indicates the surround pan position for the currently selected Input Channel. The surround pan can be set by dragging the dot. Clicking a speaker icon will move the pan position to the position of that icon.

C Surround pan position
This is the current surround pan position.

D SURROUND MODE parameter
Click this parameter to display the option list and set Surround mode to STEREO, 3-1, 5.1, or 6.1.

E [LFE] control
This rotary control sets the level of the LFE channel.

F [DIV.F] control (6.1)/[DIV] control (3-1, 5.1)
This rotary control sets the amount of divergence (i.e., how the Center signal is fed to the Left, Right,
and Center channels). With 6.1 surround, you can set the divergence for both the front and rear. The
[DIV.F] control sets the amount of divergence for the front signal.

G [DIV.R] control (6.1 only)
This rotary control sets the amount of divergence for the rear signal.

H [LINK] button (6.1 only)
This button is used to link the [DIV.F] and [DIV.R] controls.
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Index

B Surround pan graph

The Effect Editor window enables you to edit the internal effects processors. To open the Effect Editor
window, choose [Effect Editor] from the [Windows] menu.

B

3 4 5

Keyboard Shortcuts

A

UsingWindows
01V96 Editor
Windows

Note: You can open multiple Effect Editor windows by choosing [Windows] menu -> [Effect Editor] and
making a choice other than [Generic Editor]. The titles of these windows will indicate [Locked]. You cannot open Library windows from windows that are indicated as [Locked].
When you recall effects, windows that do not indicate “Locked” in the title will be recalled.

Getting Started

Effect Editor Window

F

G H
Index

A Effects processor select
These buttons are used to select the internal effects processors.

B Effect select section
The EFFECT NAME, TYPE, and IN/OUT are the name, type and I/O configuration of the effect
recalled to the currently selected effects processor. To edit the EFFECT NAME, click it and type. The
[LIBRARY] button opens the Effects Library window.

C [IN] button
This button is used to set the metering position to the effects processor’s inputs.

D [OUT] button
This button is used to set the metering position to the effects processor’s outputs.

E Meters
These are input or output meters for the currently selected effects processor.

F Effect parameter section
This section contains the various effects controls, buttons, and displays. Its layout depends on the
selected effect type.

G [MIX BALANCE] control
This control enables you to adjust the balance between the wet and dry signals. When set to 0, only the
dry signal is heard. When set to 100, only the wet signal is heard.

H [BYPASS] button
This button is used to bypass the currently selected effects processor.
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Getting Started

I PLAY/REC section
This is shown only if the selected effect type is FREEZE. To start recording (sampling), click the [REC] button and then click the [PLAY] button. The progress bar shows the current recording location. To play
back the recorded sample, click the [PLAY] button.

J TEMPO section

UsingWindows
01V96 Editor
Windows

This is shown only if the selected effect type includes a TEMPO parameter. You can turn the rotary knob to set the TEMPO parameter
directly. If you turn on the [MIDI CLK] button, the tempo will synchronize with MIDI Clock messages from an external device. If you
repeatedly click the [TAP TEMPO] button, the TEMPO parameter will
be set to the corresponding interval.

K SOLO section

Index

Keyboard Shortcuts

This is shown only if the selected effect type is M.BAND DYNA. Only
the bands that are turned on will be output. If all bands are turned on
or off, all bands will be output.
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Page
CH1-32 page

Function
This page displays the Input Channel CH1-32 meters (12 segments).

ST IN page

This page displays the Stereo Input Channel 1-4 meters (12 segments)

MASTER page

This page displays the Bus 1-8, Aux 1-8, and Stereo meters (12 segments).

Effects 1-4 page

This page displays the Channel 1 & 2 input/output meters (12 segments) for Effects
1-4.

Stereo page

This page displays a bar graph (32 segments) of signal levels output to the Stereo Out.

The layout of the Meter window pages is the same regardless of the page selected. (The Master page is
shown below.)

2

3

Index

Keyboard Shortcuts

A

Getting Started

The Meter window displays the Input, Output, Effect, and Stereo Out meters. To open the Meter window, choose [Meter] from the [Windows] menu. This window consists of four display pages. You can
access these pages by clicking the tabs along the top of the window.

UsingWindows
01V96 Editor
Windows

Meter Window

A Meter mode
You can select the type of meters to be displayed from the following options:
GATE GR: The meters indicate the amount of gain reduction being applied by the channel Gate.
COMP GR: The meters indicate the amount of gain reduction being applied by the channel
Compressor.
LEVEL:
The meters indicate the channel level.

B POSITION parameter
This parameter, available only when Meter mode is set to Level, enables you to select the metering
position in the signal path.

C PEAK HOLD button
This button turns the Peak Hold function on and off.

01V96 Editor—Owner’s Manual

31

Windows

Creates a new Session

Ctrl+N

+N

Opens a previously saved Session

Ctrl+O

+O

Saves the current Session

Ctrl+S

+S

Undo

Ctrl+Z

+Z

Redo

Ctrl+Y

+Y

Closes the active window

Ctrl+W

+W

Closes all windows

Ctrl+Alt+W

+Option+W

Opens the Master window

Ctrl+1

+1

Opens the Layer window

Ctrl+2

+2

Opens the Selected Channel window

Ctrl+3

+3

Opens the Library window

Ctrl+4

+4

Opens the Patch Editor window

Ctrl+5

+5

Opens the Surround Editor window

Ctrl+6

+6

Opens the Effect Editor window

Ctrl+8

+8

Opens the Meter window

Ctrl+9

+9

Selects consecutive multiple items (memories)

Shift+click

Selects non-consecutive multiple items (memories)

Ctrl+click

+click

Selects all memories in a section

Ctrl+A

+A

Edit menu

shift+click

Index

Windows menu

Library window

Macintosh

UsingWindows
01V96 Editor
Windows

File menu

Action

Keyboard Shortcuts

Menu

Getting Started

Keyboard Shortcuts
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A
ALL CLEAR button ................ 23, 24
AUTO SETUP button ............ 23, 24
AUX section ................................... 10
Aux Section ...................................... 9
Aux Send level section .................. 18
AUX SEND section ................. 15, 16
Aux Sends ...................................... 18

B
Balance & level section .................. 19
Bus Outs ......................................... 17
BYPASS button ............................. 29

C
CH1-32 page .................................. 31
Channel Copy Parameter ............... 3
Channel fader .......... 9, 11, 12, 13, 16
Channel IDs ................. 23, 24, 25, 27
Channel Library ............................ 21
Channel meter ..................... 9, 11, 12
Channel number ........... 9, 10, 12, 13
Channel Select ................................. 3
CHANNEL SELECT section
............ 14, 16, 17, 18, 19, 28
CLEAR button ............................... 22
CLOSE button ............................... 22
COMP button ........................... 8, 12
Compressor curve ..................... 8, 12
Compressor Library ...................... 21
COMPRESSOR section
........................ 15, 18, 19, 20
Configuring the Editor ................... 2
Confirmation ................................... 3
Console -> PC ............................. 3, 4
Console Device ID .......................... 2
Console Setup .................................. 3
Copy ................................................. 6
Creating a new Session ................... 4
Ctrl + click ....................................... 6
Ctrl + Shift + Click .......................... 6

D
DELAY & PHASE section ............ 15
DELAY button ........................... 8, 12
Delay parameter ........................ 9, 12

E
Effect editor window .................... 29
Effect Library ................................. 21
EFFECT NAME ............................ 29
Effect parameter section ............... 29
Effect patch page ........................... 26
EFFECT TYPE .............................. 29
Effects 1-4 page ............................. 31
Effects processor 1–4 section ....... 26
Effects processor select ................. 29
EQ button .............................8, 10, 12
EQ curve .........................8, 10, 12, 16
Equalizer Library .......................... 21
EQUALIZER section
...................15, 16, 17, 18, 19

F
F.PAN button ................................ 16
FADER GROUP buttons
...................15, 17, 18, 19, 20
FADER GROUP section
...................15, 17, 18, 19, 20
Fader value indicator .......7, 9, 12, 13
File name ....................................... 21
FILE section ................................... 22

G
GATE button .................................. 8
Gate Library .................................. 21
Gate open/close indicators ............. 8
GATE section ................................ 14
Gate threshold ................................. 8
Group Master Fader ..................... 13

I
IN button ....................................... 29
Index .............................................. 33
Input Channels ..........................8, 14
Input Patch Library ...................... 21
INPUT PATCH LINK .................. 22
Input patch page ........................... 23
INPUT PATCH section ..........14, 16
Input Port/Output Port ................. 2

K
Keyboard shortcuts .......................32

L
LAYER button ..................... 7, 12, 13
Layer Select ......................................3
Layer Windows ................................8
Level Meter ......................................3
level section ....................................15
LFE control .......................... 9, 10, 28
Library
Channel ....................................21
Compressor ..............................21
Effect .........................................21
Equalizer ...................................21
Gate ...........................................21
Input Patch ..............................21
Output Patch ...........................21
LIBRARY button
...... 16, 17, 23, 24, 25, 26, 27
LIBRARY section ...........................14
Library Window ............................21
LINK button (6.1 only) ................28
Long channel names ... 23, 24, 25, 27

M
Master fader .....................................7
MASTER page ...............................31
Master Window ...............................7
Meter mode ...................................31
Meter Window ..............................31
Meters ......................................... 7, 29
MIX BALANCE control ...............29
MUTE GROUP buttons
.................. 15, 17, 18, 19, 20
MUTE GROUP section
.................. 15, 17, 18, 19, 20

O
Offline ..............................................7
Offline Edit .................................. 4, 7
ON button ..... 7, 9, 11, 12, 13, 16, 17
ONLINE/OFFLINE button ............7
OPEN button .................................22
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INSERT button .......................... 8, 12
Insert In Patchbay .........................25
Insert Out Patchbay ......................25
Insert patch page ...........................25
INSERT section ........... 15, 17, 18, 19
INTERNAL DATA section ...........22

UsingWindows
01V96 Editor
Windows

1-16 button ...................................... 7
17-32 button .................................... 7

DELAY section ...................17, 18, 19
DIRECT button .........................8, 16
Direct Out parameter ................8, 16
Direct out patch page ................... 27
DIV.F control/DIV control .......... 28
DIV.R control (6.1 only) .............. 28
dry signal ....................................... 29

Keyboard Shortcuts

Numerics

Index

Index

R
RECALL button ............................ 22
Redo ................................................. 5
Remote Channels .......................... 13
Remote target name ...................... 13
Resynchronizing 01V96 Editor ...... 4
ROUTING buttons ............. 8, 10, 16
ROUTING section ........................ 15

S
SAVE AS button ............................ 22
SAVE button .................................. 22
Saving the current Session .............. 4
Saving the current Session with a
new name .......................... 4
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